Utilities
## INTRODUCTION

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminology and conventions</td>
<td>6</td>
</tr>
<tr>
<td>About this document</td>
<td>7</td>
</tr>
<tr>
<td>About Help</td>
<td>7</td>
</tr>
</tbody>
</table>

## INSTALLING USER SOFTWARE

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing for installation on Windows computers</td>
<td>8</td>
</tr>
<tr>
<td>Installing user software on a Windows computer</td>
<td>9</td>
</tr>
<tr>
<td>Installing user software on a Mac OS computer</td>
<td>11</td>
</tr>
<tr>
<td>Uninstalling user software on a Mac OS computer</td>
<td>12</td>
</tr>
<tr>
<td>Uninstalling user software on a Windows computer</td>
<td>12</td>
</tr>
</tbody>
</table>

## COMMAND WORKSTATION

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command WorkStation utilities</td>
<td>14</td>
</tr>
<tr>
<td>Installing Command WorkStation</td>
<td>15</td>
</tr>
<tr>
<td>Configuring the connection to the EX Print Server</td>
<td>15</td>
</tr>
<tr>
<td>Using Command WorkStation</td>
<td>17</td>
</tr>
<tr>
<td>About Help</td>
<td>17</td>
</tr>
<tr>
<td>Additional features</td>
<td>18</td>
</tr>
<tr>
<td>Mixed Media</td>
<td>18</td>
</tr>
<tr>
<td>Tab printing</td>
<td>23</td>
</tr>
<tr>
<td>Loading tab stock on the press</td>
<td>24</td>
</tr>
<tr>
<td>Specifying settings at the press</td>
<td>25</td>
</tr>
<tr>
<td>Specifying tab settings in Command WorkStation</td>
<td>25</td>
</tr>
<tr>
<td>ImageViewer</td>
<td>29</td>
</tr>
<tr>
<td>CONTENTS 4</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td></td>
</tr>
</tbody>
</table>

Troubleshooting 30

- Command WorkStation cannot connect to the EX Print Server 30
- Command WorkStation does not respond 30

**FIERY SEEQUENCE SUITE** 31

**About the SeeQuence Suite Kit** 31

**Installing and enabling Fiery SeeQuence Suite** 32

- Installing SeeQuence software 32
- Enabling SeeQuence software 32

**About Help** 34

**PAPER CATALOG** 35

**Installing Paper Catalog** 35

**Specifying Paper Catalog media for jobs** 35

**HOT FOLDERS** 38

**Installing Hot Folders** 38

- Upgrading from a previous version of Hot Folders 38

**Using Hot Folders** 39

**WEBTOOLS** 40

**Setting up WebTools** 40

**Accessing the WebTools home page** 41

**Using WebTools** 42

- Home 42
- Downloads 42
- Docs 42
- Configure 42

**INDEX** 43
The Xerox EX Print Server, Powered by Fiery for the Xerox Color 1000 Press media pack includes a set of software utilities that allow you to manage the Xerox EX Print Server, Powered by Fiery for the Xerox Color 1000 Press, as well as the print workflow and content of jobs on the Xerox EX Print Server, Powered by Fiery for the Xerox Color 1000 Press.

This document provides an overview of how to install, configure, and use the following Xerox EX Print Server, Powered by Fiery for the Xerox Color 1000 Press utilities:

- Command WorkStation
- Fiery SeeQuence Suite
  - Fiery SeeQuence Preview
  - Fiery SeeQuence Impose
  - Fiery SeeQuence Compose
- Paper Catalog
- Hot Folders
- WebTools
**Terminology and conventions**

This document uses the following terminology and conventions.

<table>
<thead>
<tr>
<th>Term or convention</th>
<th>Refers to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aero</td>
<td>EX Print Server (in illustrations and examples)</td>
</tr>
<tr>
<td>EX Print Server</td>
<td>Xerox EX Print Server, Powered by Fiery for the Xerox Color 1000 Press</td>
</tr>
<tr>
<td>Mac OS</td>
<td>Apple Mac OS X</td>
</tr>
<tr>
<td>Press</td>
<td>Xerox Color 1000 Press</td>
</tr>
<tr>
<td>Titles in <em>italics</em></td>
<td>Other documents in this set</td>
</tr>
</tbody>
</table>

- **Help in the software**: Topics for which additional information is available by starting Help in the software.
- **Tips and information**
- **WARNING**: A warning concerning operations that may lead to death or injury to persons if not performed correctly. To use the equipment safely, always pay attention to these warnings.
- **CAUTION**: A caution concerning operations that may lead to injury to persons if not performed correctly. To use the equipment safely, always pay attention to these cautions.
- **IMPORTANT**: Operational requirements and restrictions. Be sure to read these items carefully to operate the equipment correctly, and avoid damage to the equipment or property.
About this document

This document covers the following topics:

- **Command WorkStation** monitors and manages the print workflow of jobs on the EX Print Server.
- **Fiery SeeQuence Suite** integrates document preparation activities at both the sheet level and page level in one visual interface.
  - **Fiery SeeQuence Preview** provides a pre-RIP soft proof of each sheet surface of a job. Changes dynamically to display any changes made in preparing documents for printing.
  - **Fiery SeeQuence Impose** applies imposition layouts to jobs for custom printing, binding, and cutting purposes.
  - **Fiery SeeQuence Compose** defines the chapter divisions of a job, printing ranges of pages on varying types of media, inserting blank media between pages, and tab media containing text labels.
- **Paper Catalog** defines and stores the attributes of printing media in a system-based paper warehouse database.
- **Hot Folders** stores frequently used print options when printing PostScript and PDF files on the EX Print Server.
- **WebTools** manages your EX Print Server remotely from the Internet or your company's intranet.

For information about using color management, see *Color Printing*.

About Help

Detailed instructions on using most EX Print Server utilities are provided in the online Help. Wherever appropriate, this document refers you to Help for additional information and explains how to access Help for each utility.
INSTALLING USER SOFTWARE

This chapter describes installation of EX Print Server user software on both Windows and Mac OS computers.

You can install EX Print Server user software in the following ways:

• From the User Software DVD
• From the EX Print Server, using the Internet or intranet
• From the EX Print Server directly, over the network

If you have previously installed any EX Print Server user software on your computer, the installer allows you to uninstall those applications during the process.

Preparing for installation on Windows computers

Before installing EX Print Server software on a Windows computer, be sure to complete the following:

• To use EX Print Server user software on a Windows computer, the Sun Java file, Java Runtime Environment (JRE), provided in the Common Utilities folder on the User Software DVD, must be installed on your computer. If the correct Sun Java file is not installed, the Fiery User Software Installer installs it automatically before installing the EX Print Server software.

Note: The recommended version of Sun Java JRE is provided on the User Software DVD.

• To install the EX Print Server software, you must have Service Pack 2, or Service Pack 3, installed on a Windows XP computer. If not, a warning message alerts you to install the Service Pack.

After installation of Sun Java JRE, a Java Web Start shortcut is created on your computer desktop. The shortcut is not intended for use with EX Print Server software and can be deleted.

Different versions of Sun Java JRE can be installed on your computer. The EX Print Server software automatically finds the correct version, so you do not need to uninstall other versions of Sun Java JRE required for third-party applications.
**Installing user software on a Windows computer**

All installation of user software on a Windows computer is done through the Fiery User Software Installer. The following procedures describe installing from the User Software DVD, over the network, or over the Internet, and also modifying the user software.

The only applications that are not installed by the Fiery User Software Installer are Adobe Acrobat and Enfocus PitStop, for use with Fiery SeeQuence Suite. For more information, see "Installing and enabling Fiery SeeQuence Suite" on page 32.

---

**To install user software on a Windows computer from the User Software DVD**

1. Insert the User Software DVD into the DVD drive of the computer.

   The Welcome screen of the installer appears.

2. Follow the on-screen instructions.

   **IMPORTANT**

   Do not attempt to install user software by opening the individual folders for the applications. To modify or remove user software after you have installed it on your computer, use the User Software DVD and the following procedure.
TO MODIFY USER SOFTWARE USING THE User Software DVD Installer

1 Insert the User Software DVD into the DVD drive of your computer.

2 On the window that appears, select Add/Remove, Repair, or Remove.

3 Follow the on-screen instructions.

If your computer does not have a DVD drive, you can install the user software from the EX Print Server over the network. Ask your network administrator for the IP address or the DNS server name of the EX Print Server.

You can also install the user software from the EX Print Server over the Internet. Ask your network administrator for the IP address of the EX Print Server.

Use your Internet browser to access WebTools. For complete information about browser and system requirements, see Welcome.

TO INSTALL USER SOFTWARE ON A Windows computer over the Network

1 Click Start, choose Run, and type the IP address or DNS server name of the EX Print Server.

2 Type the user name and password, if required.
   Consult your network administrator to see if a password is required.

3 Double-click the PC_User_SW directory.

4 Double-click the Master Installer icon.

5 Follow the on-screen instructions.

TO INSTALL USER SOFTWARE ON A Windows computer over the Internet using WebTools

1 Start your Internet browser.

2 Type the IP address or DNS name of the EX Print Server.
   The EX Print Server home page appears.

3 Click the Downloads tab.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or choose Save to save it to your computer.

6 If you choose Run, proceed to step 9.

7 If you choose Save, browse to the location where you want to save the USERSWMI.exe file, and then click Save.
   The file is downloaded from the EX Print Server.

8 Double-click the USERSWMI.exe file.

9 Type the EX Print Server URL, http://<IP address>, when prompted.

10 Follow the on-screen instructions.
For complete instructions on how to use Downloads, see the online Help.

For more information about WebTools and Downloads, see page 40.

Do not attempt to install user software by opening the individual folders for the applications. Always use the Fiery User Software Installer.

**Installing user software on a Mac OS computer**

Installation of user software on a Mac OS computer is done separately for each application. If necessary, you can uninstall the user software using the Fiery Software Uninstaller. The following procedures describe installing and uninstalling user software.

For information on installing printer drivers, see *Printing*.

---

**To install user software on a Mac OS computer from the User Software DVD**

1. Insert the User Software DVD into the DVD drive of your computer.
2. Browse to the OSX folder.
3. Double-click the installer icon for the application that you want to install.
4. Follow the on-screen instructions.

You can also install the user software from the EX Print Server over the Internet. Consult your network administrator for the IP address of the EX Print Server.

Use your Internet browser to access WebTools. For complete information about browser and system requirements, see *Welcome*.

---

**To install user software on a Mac OS computer over the network**

1. Choose Connect to Server from the Go menu.
2. Type smb:// followed by the IP address of the EX Print Server, and then click Connect.
   - If you cannot locate the EX Print Server, contact your network administrator.
3. Type the user name and password, if required.
   - Consult your network administrator to see if a password is required.
4. Select the smb shared volume that you want to connect to.
5. Select Mac_User_SW and click OK.
6. Open the OSX folder.
7. Double-click the installer icon for the application that you want to install.
8. Follow the on-screen instructions.
To install user software on a Mac OS computer over the internet using WebTools

1 Start your Internet browser.
2 Type the IP address or DNS name of the EX Print Server.
   The EX Print Server home page appears.
3 Click the Downloads tab.
4 Click the link for the software that you want to install.
   The osxutils.dmg file is downloaded to your computer and a virtual disk appears on your desktop.
5 Follow the on-screen instructions.

For complete instructions on how to use Downloads, see the online Help.
For more information about WebTools and Downloads, see page 40.

Uninstalling user software on a Mac OS computer

To remove user software after you have installed it on your Mac OS computer, use the Fiery Software Uninstaller utility and the following procedure.

To uninstall user software on a Mac OS computer

1 Insert the User Software DVD into the DVD drive of your computer.
2 Browse to the OSX folder.
3 Click the icon for the Fiery Software Uninstaller.
4 Select the software you want to uninstall and follow the on-screen instructions.

Uninstalling user software on a Windows computer

To remove user software after you have installed it on your Windows computer, use the Fiery User Software Installer. See “To modify user software using the User Software DVD Installer” on page 10.
Command WorkStation enhances the user experience and improves productivity. The cross-platform application gives operators the means to manage jobs on the EX Print Server, and administrators the means to configure the EX Print Server for printing. Command WorkStation includes the Job Center for job management, Device Center for server management, and Fiery SeeQuence Suite for preparing jobs for printing.

In both Job Center and Device Center views, the Server List shows all the EX Print Server servers you are connected to. You can switch between servers, and add or remove them from the list. Information about consumables on the press, tray association status, and errors and alerts is available.

- **Job Center** displays the tools for managing jobs in the print queues, and a job preview of processed jobs. The status of jobs is shown. You can search for jobs and access features from the customizable toolbar.

- **Device Center** gives you access to all the resources of the EX Print Server. From the Device Center, you can access setup and tools such as calibration and back up and restore. You can perform Color Setup, configure virtual printers, and create Paper Catalog entries.

Command WorkStation allows you to perform the following tasks:

- View the print status of jobs on the EX Print Server
- Hold, process, and print jobs
- Override user-assigned print option settings
- Preview the page content of a job
- Reorder pages in a job and combine pages from different jobs
- Create and use FreeForm master files for variable data printing
- Archive job files
- View job logs of recent print activity
- Define virtual printers
- Manage fonts
- Access Fiery SeeQuence Suite
- Merge jobs
- Access color management settings
Command WorkStation utilities

Command WorkStation provides access to the following utilities:

- Backup and Restore
- Booklet Maker
- Calibrator
- Color Management
- Configure
- Fiery JDF
- Job Properties
- Paper Catalog
- Quick Doc Merge
- Tray Alignment
- Tray Association
- Fiery SeeQuence Impose
- Fiery SeeQuence Compose
Installing Command WorkStation

Install Command WorkStation on a Microsoft Windows or Mac OS computer that has a network connection to the EX Print Server. For a complete list of system requirements, see Welcome.

The installer for Command WorkStation is provided on the User Software DVD as part of the Fiery User Software Installer (Windows computers) or as a separate application (Mac OS X). To install Command WorkStation, see “Installing user software” on page 8.

Configuring the connection to the EX Print Server

The first time you start Command WorkStation, you are prompted to configure the connection to the EX Print Server. You can also edit the configuration whenever there is any change to your EX Print Server or network, such as a changed server name or IP address. If you change EX Print Server Setup information, do so before you reconfigure the connection.

BEFORE YOU BEGIN

- Print the EX Print Server Configuration page.

For instructions on printing the Configuration page, see Configuration and Setup, which is part of the user documentation set.

The EX Print Server Configuration page contains information you need when configuring the connection, such as the IP address of the EX Print Server. For TCP/IP installations, you can use the DNS name instead of the IP address. Make sure that the EX Print Server is registered in a Domain Name Server (DNS) on your network. For more information, contact your network administrator.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION

1 Start Command WorkStation:

Windows: Programs > Fiery > Fiery Command WorkStation 5

Mac OS: Applications: Fiery: Command WorkStation 5: Command WorkStation

2 Type the DNS name or IP address and click Add to add the server to the Disconnected Servers list.

If no EX Print Server is found, click the icon, search by a range of IP addresses or by the IP address and subnet mask, and then click Go. Or, select Auto Search.
All available servers appear in the Available Servers list.

To search for a particular server in the Available Servers list, type the server name in the Filter by keyword field.

Select the EX Print Server that you want to use, click Add, and then click Connect.

The Login dialog box appears.

3 Select Administrator, Operator, or Guest and type the appropriate password, if required.

Consult your administrator for information about passwords for the EX Print Server you want to connect to.

For information about setting passwords and the default Administrator password for the EX Print Server, see Configuration and Setup, which is part of the user documentation set.

4 Click Log In.

Command WorkStation is now connected to the EX Print Server.

For information about managing and connecting additional EX Print Server servers, see Command WorkStation Help.
Using Command WorkStation

After you install and configure Command WorkStation, you can begin using it to monitor and manage jobs on the EX Print Server.

About Help

For instructions on using Command WorkStation features, see Command WorkStation Help. The Help menu offers access to the following kinds of Help:

- **Online Help** provides procedural information.
- **How To** accesses the EFI web page, which provides demo scripts and sample files.
- **What's New** describes the new features of Command WorkStation.

**TO ACCESS COMMAND WORKSTATION HELP**

1. Start Command WorkStation.

   Select the EX Print Server from the Server List dialog box and log on to the server.

   For information about setting passwords and the default Administrator password for the EX Print Server, see *Configuration and Setup*.

2. Choose Help, How To, or What’s New from the Help menu.
Additional features

The following sections describe how to use additional features of Command WorkStation that are not discussed in Command WorkStation Help.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of pages on varying types of media, insert blank media between pages, and insert tab media containing text labels (if the press supports tab printing).

The following guidelines and restrictions apply to Mixed Media settings:

- The Mixed Media dialog box restricts you from specifying settings that conflict with any media, page size, or finishing settings that have been specified for the job in the Job Properties dialog box or printer driver.
- When two or more Mixed Media settings are in conflict with each other, the Mixed Media dialog box highlights the setting names in red, signaling you to resolve the conflict.
- When you specify print options (in the Job Properties dialog box or printer driver) after specifying Mixed Media settings, certain print options may conflict with the page-specific Mixed Media settings. You must resolve the conflict by choosing different print options or removing certain Mixed Media specifications.
- Mixed Media settings affect the use of output color profiles when the “Use media defined profile” option is selected in Color Setup. For more information, see Color Printing.
- If counters are configured for the press, blank media inserted between pages count as printed pages.

Basic instructions for accessing and using Mixed Media are provided in Command WorkStation Help. Features specific to the EX Print Server are described in the following procedures.
**To define Mixed Media specifications**

1. Select or right-click a spooled/held job in the Job Center view and choose Properties from the Actions menu, or double-click a job.

2. Click the Media icon and scroll down to Mixed Media.

   The Mixed Media dialog box lists any previously defined media settings and includes buttons for defining, modifying, and removing settings.

3. For Chapter Start Page(s), type the page numbers on which you want to start new chapter sections.

   Type page numbers as comma-separated values (for example: 4,9,17) to designate the start of each new chapter. This feature forces each starting page to use a right-side page, adding a preceding left-sided blank, if required.

   **Note:** It is not necessary to type the first page, and page numbers refer to the numbering of the original document. If you use the Chapter Start Page(s) feature, all media specified in the Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, or all A4).
4 To apply finishing options (for example, stapling or sorting) to each chapter created using the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” option.

**NOTE:** Not all finishing options can be applied to chapters that contain mixed sizes of media (for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover.

For more information, see “To define cover media settings” on page 21.

6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 22.

7 To insert tab media, click New Tab.

The Insert Tab dialog box appears. For information about defining tab settings, see page 25.

**NOTE:** The Insert Tab feature is not available for imposed jobs.

8 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 23.

9 To modify or delete a current definition, select it in the Mixed Media Definition list, and click Edit or Remove.

If you click Edit, enter new settings for the definition and click Modify.

10 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box and Job Properties.

The Mixed Media settings are applied to the job.

**NOTE:** You can save up to 100 different settings for the Selection list in the Mixed Media dialog box.
To define cover media settings

1. In the Mixed Media dialog box, click Define Cover.

   The Cover Media dialog box appears.

2. To define identical front cover and back cover media, select the “Apply the same settings for both front and back cover” option. To define media settings for the front or back cover individually, select the Front Cover or Back Cover option.

3. Choose other settings, as required, from the pull-down menus.

4. Choose the required media from the Media menu.

   To select media from Paper Catalog, select Choose from Paper Catalog from the Media menu.

   The media that you selected appears in the main Cover Media window.

   For more information about Paper Catalog, see page 35.

5. Click OK to return to the Mixed Media dialog box.

   Cover Media settings override settings defined in the Page/Page Range Media dialog box.
TO DEFINE MEDIA FOR SPECIFIC PAGES

1. In the Mixed Media dialog box, click New Page Range.

   The Page/Page Range Media dialog box appears.

2. Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3. Choose other settings, as required, from the pull-down menus.

   If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to
force the assigned page content to the front side of the next sheet.

4. Choose the required media from the Media menu.

   To select media from Paper Catalog, select Choose from Paper Catalog from the Media menu.

   The media that you selected appears in the main Page Range window.

   For more information about Paper Catalog, see page 35.

5. Click Add Definition after each media setting that you define.

6. Click Close to return to the Mixed Media dialog box.
TO INSERT BLANK PAGES

1 Click New Insert in the Mixed Media dialog box.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target page as the first or last page in the document, or as a specific numbered page.

3 Choose other settings, as required, from the pull-down menus.

4 Choose the required media from the Media menu.

To select media from Paper Catalog, select Choose from Paper Catalog from the Media menu.

The media that you selected appears in the main Insert Blank window.

For more information about Paper Catalog, see page 35.

5 Click Insert after each blank page that you define.

6 Click Close to return to the Mixed Media dialog box.

Tab printing

This section explains how to print tab jobs from the EX Print Server.

To print a job with tabs, you must perform the following tasks:

- Load tabs on the press.
- Specify settings on the press user interface (the computer, monitor, and keyboard attached to the Xerox® Color 1000 Press).
- Specify settings in Command WorkStation on the EX Print Server.
Loading tab stock on the press

Load the press with the tab media that you want to use. You can load tab stock SEF or LEF, but note that tabs are printed left to right and face down in reverse order. See the following procedure:

To load tab media stock

1. **Select the tab stock for your job.**
2. **Pull out the tray you want to load the tabs in.**
   - Tab stock can be loaded in Tray 1, Tray 2, or Trays A1-1/A1-2, if installed.
   - The media for the main part of the job is loaded in a different tray.
3. **Load the tab media stock without flipping the stock.**
   - The first tab is always on the bottom of the collated media stock, and the job prints face down.
   - **Note:** Even if you specify only one tab to be inserted in a job, you must load a complete set of the tab media stock. If you specify two tabs to be inserted and printed, the remaining tab stock will be output as blank pages.
4. **Load and align the edge of the tab media stock against the right edge of the tray with the side to be printed on facing down.**
   - Placement of tabs in tray is as follows:
     - **SEF (Short Edge Feed):** tabs up and facing toward the rear of tray
     - **LEF (Long Edge Feed):** tabs up and facing to the left of the tray
5. **Adjust the paper guides and skew adjustment levers if necessary.**
6. **Push in the tray.**

For information on press functionality, refer to the documentation that comes with the press.

**Note:** Tab media cannot be printed duplex.

To specify media settings, such as page size and weight, where to insert tabs in your document, and the content and properties of tab text, see the following sections.
Specifying settings at the press

In the Paper Tray Properties window on the press user interface, enter the correct media information for the tab media loaded in the tray. Note the following:

- For LEF Letter size tab stock, the selected page size should be 9 × 11. For LEF A4 tab stock, the selected page size should be Tab - Europe LEF.
- For SEF jobs, select Custom Size and enter 11 inches (Letter) or 296 mm (A4) for the width and 9 inches (Letter) or 223.5 mm (A4) for the height.
- Make sure that the correct orientation direction (either SEF or LEF) for the media loaded in the tray is selected.
- Specify the media type.

Specifying tab settings in Command WorkStation

In Command WorkStation, you can insert tab pages throughout a job. This feature accommodates various sizes and types of tab media stock. You can insert tab text and override text attributes on a per-job basis.

To insert pre-cut or full-cut tabs with pre-printed text, you can use the New Page Range feature of Mixed Media. To insert tabs and specify tab text, use the New Tab feature in Mixed Media.

Specifying specific pages as tab pages

To use the New Page Range feature of Mixed Media, see the procedure on page 22.

When specifying settings for the tab media inserts, you must set the following:

- **Paper Size**: Select 9 × 11 LEF (Letter) or Tab - Europe LEF (A4). For SEF, select Custom Paper Size and enter 11 inches or 296 mm for the width and 9 inches or 223.5 mm for the height.
- **Media**: Select a tab stock.
- **Preprinted Stock**: Select Yes.
- **Duplex**: Select Off.
- **Media Type**: Select one of the tab types listed.
- **Paper Source**: Select the specific tray where the tab stock is loaded.

Specify other settings as required.
Using the Insert Tab feature

Use the Insert Tab feature to insert tab stock to your job when you want to specify tab text to be printed. Use the following procedure to insert tab pages.

To insert tab pages

1. Select or right-click a spooled/held job in the Job Center view and choose Properties from the Actions menu, or double-click a job.

2. Click the Media icon and scroll down to Mixed Media.

3. Click New Tab in the Mixed Media dialog box.

The Insert Tab dialog box appears.

4. Type the number of tab positions included in a complete tab set in the “Number of tabs in a set” field.

This specification ensures that tab text is printed in the correct tab positions. For example, tab positions in a set consisting of ten tabs are distinct from tab positions in a set consisting of five tabs.
5 For Paper Source, specify the tray in which tab stock is loaded.

6 Select the tab stock from the Paper Catalog menu.

7 Select the Tab Sequence.

Forward is the default order loading the tab stock.

8 For Media Type, select one of the tab stocks listed.

9 Specify the Output Tray to Kick Out Unused Tabs.

For more information about this setting, see page 29.

10 Select the Page Size.

Page Size values refer to the dimensions of the stock, including the tabbed portions.

11 Specify other settings, as required, for the tab stock.

12 To specify attributes for the tab text, type the number of tabs in the “Number of tabs to insert” field, and then click Insert.

Use the following procedure to define the tab text.
To Specify Tab Text

1. In the Tabs Text dialog box, select the “Apply the same text attributes for all tabs” option if you want all the tabs to use the same text attributes.

2. Click Insert.

3. Click Text Attributes.

   Specify the rotation, alignment, font, and size attributes of the tab text, and then click OK.

4. Indicate where you want each tab inserted in the document.

   - In the Page field, type the page number where you want the tab inserted.
   - Select Before to insert the tab before the page number, or clear this check box.

   NOTE: If you define a tab to be inserted between an odd-numbered page and an even-numbered page in a duplex job, the tab is inserted after the odd-numbered page on the first sheet, and the even-numbered page is printed on the next sheet.

5. Type the desired tab text for each tab in the Tab Text field.

   To define text attributes for each tab individually, click Text Attributes for that tab.

6. After you type the tab text, click OK to close the Insert Tab dialog box.

   The Mixed Media dialog box displays the current tab settings in the Mixed Media Definition list.

7. To modify media settings for the tabs, select the tab description in the Mixed Media Definition list, and then click Edit.

8. To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog box and Job Properties.
Output Tray for Unused Tabs

Unused tabs can be sent to a specific output tray. For example, if you print a three-tab job and are using tab paper that has five tabs in a set, the fourth and fifth tabs are unused. To select the output tray for unused tabs, click New Tab in the Mixed Media window, select Output Tray to Kick Out Unused Tabs, and then choose the output tray from the drop-down menu.

From Insert Tab, specify:

- Number of tabs in the set of tab paper that you are using
- Tab positions
- Page number of tabs

**NOTE:** Output Tray to Kick Out Unused Tabs is only available when you print multiple copies for your tab job. You cannot specify a finisher for the unused tab paper output tray if that finisher is not used for your job. If a paper jam occurs, the press outputs the balance of the tabs in the set. When the jam has been cleared, the press resumes printing the set with the tabs in the correct order.

**ImageViewer**

If the Fiery Graphic Arts Package, Premium Edition is installed and enabled on the EX Print Server, you can use ImageViewer to preview and adjust colors on a job that has been processed and held. For information about using ImageViewer, see *Fiery Graphic Arts Package*.

**NOTE:** When available, ImageViewer replaces the standard full-screen preview window described in Command WorkStation Help.
Troubleshooting

When troubleshooting basic connection and software problems with Command WorkStation, see the following sections. For additional troubleshooting information, see Command WorkStation Help.

Command WorkStation cannot connect to the EX Print Server

If you cannot connect to the EX Print Server or locate the EX Print Server from your computer, contact the network administrator. The administrator may need to troubleshoot your network connections and check settings on the servers that you print to. If settings have changed, it may be necessary to reconfigure the EX Print Server (see Configuration and Setup).

If you can connect to the EX Print Server with another utility, you may need to reconfigure the Command WorkStation connection to the EX Print Server (see page 15).

If you configured the EX Print Server and set up client computers and network servers according to the instructions in Configuration and Setup, print a Test Page. If you can print the Test Page but still cannot print a document from a remote computer, contact your network administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the press user interface for error information.

Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

**If the Command WorkStation windows do not update**

1. Log off and then quit Command WorkStation.
2. Restart Command WorkStation or restart the computer.

   If the Command WorkStation windows do not update or no jobs are displayed, and the mouse has no effect (you cannot select a job or a window, use a right mouse command, or select a menu item), the EX Print Server is offline or network communication has failed.

**To force an exit from Command WorkStation**

1. On a Windows computer, press Ctrl-Alt-Delete and use the Program Manager to close Command WorkStation.
   
   On a Mac OS X computer, choose Apple menu > Force Quit, select Command WorkStation, and then click Force Quit. Or, press Command+Option+Esc, select Command WorkStation, and then click Force Quit.
2. At the EX Print Server, disconnect and reconnect the network cable, and then try printing a Test Page or Configuration page.
3. If printing fails, restart the EX Print Server.
Fiery SeeQuence Suite is an integrated job preparation tool, which offers the following modes, depending on what (if any) client dongle is available:

- **Preview** provides a pre-rip job preview.
- **Fiery SeeQuence Compose** allows you to define the chapter divisions of a job, print ranges of pages on varying types of media, insert blank media between pages, and insert tab media containing text labels (if the press supports tab printing).
- **Fiery SeeQuence Impose** applies imposition layouts to jobs for custom printing, binding, and trimming. Impose also applies impositions to variable data jobs and saves imposed jobs as PDF files.
- **Fiery SeeQuence Suite** integrates Impose and Compose features in the Preview window.

**NOTE:** Fiery SeeQuence Suite is provided as a standard feature with the EX Print Server.

**About the SeeQuence Suite Kit**

Fiery SeeQuence Suite software is available in the following kit configuration:

- **Fiery SeeQuence Suite kit**, which includes both SeeQuence Impose and SeeQuence Compose (includes the Adobe Acrobat/Enfocus PitStop DVD and a single dongle)

SeeQuence Impose and SeeQuence Compose are supported on both Windows and Mac OS computers. For information about system requirements, see **Welcome**.

**NOTE:** You must have the software kit-specific dongle installed on your computer to use the full functionality of the software. If you do not have the dongle installed, SeeQuence runs in Demo mode. In Demo mode, imposed jobs print with a watermark, and you can save imposed jobs in .dbp format to the EX Print Server. You can save imposed jobs in Adobe PDF format to a hard drive and the EX Print Server when you are in Demo mode, but they are saved with a watermark.
Installing and enabling Fiery SeeQuence Suite

The following sections describe how to install and enable SeeQuence Suite.

Installing SeeQuence software

SeeQuence Suite software is installed with Command WorkStation software. For information on installing Command WorkStation software, see page 8 and page 15.

Enabling SeeQuence software

SeeQuence Impose and SeeQuence Compose are dongle-protected features of Command WorkStation that work in conjunction with Adobe Acrobat and the Enfocus PitStop plug-in. You must install a special dongle on each computer that runs the SeeQuence software. This section explains how to install the dongle and the required software.

You will need the following items:

- **Dongle**: A USB dongle included in the following kit:
  - Fiery SeeQuence Suite kit, which includes both SeeQuence Impose and SeeQuence Compose (includes a single dongle)

  **NOTE**: If you have purchased an earlier version of Impose or Compose, you can use the dongles you already own to enable SeeQuence Impose or SeeQuence Compose.

- **Adobe Acrobat/Enfocus PitStop DVD**: Included in the SeeQuence Suite kits. Contains installers for Adobe Acrobat version 9 and Enfocus PitStop, a plug-in module for Acrobat, for both Windows and Mac OS X.

  **NOTE**: Acrobat must be installed on the same computer as the SeeQuence software to preview .ps files. You do not need Acrobat or PitStop to preview .pdf files.

If it is not already installed, you will need to install Command WorkStation (see page 15). Installing Command WorkStation installs the core SeeQuence software.
To enable SeeQuence software on a computer (or the EX Print Server, if it supports, and is equipped with, a monitor, keyboard, and mouse), do the following:

- Install the dongle provided in your kit directly on the computer. One dongle is required for each client computer.
- Install Acrobat and PitStop from the installer DVD (Windows or Mac OS) provided in this kit.

**NOTE:** If you are enabling SeeQuence software on the EX Print Server, the following procedures assume that you have logged on to the EX Print Server with Administrator privileges and typed the appropriate password. To ensure network security, the system administrator may change this password frequently. Consult your administrator to obtain the password.

---

**TO INSTALL THE DONGLE**

1. **If Command WorkStation is installed and running on the client computer, exit Command WorkStation.**

   **NOTE:** If Command WorkStation is running, the dongle installation (described in step 2) will fail.

2. **Unpack the dongle and install it directly into the computer’s USB connector.**

   Insert the dongle into the USB connector of the computer. Make sure that the dongle is securely installed in the connector.

   Install Acrobat and PitStop, as described in the following procedure.
To install Acrobat and PitStop

1. If you do not have the most recent version of Adobe Acrobat and Enfocus PitStop installed, uninstall the versions of Adobe Acrobat and Enfocus PitStop that are currently resident on the computer.

   **NOTE:** SeeQuence supports Acrobat 7, 8, and 9 on Windows computers, and Acrobat 8 and 9 for Mac OS computers.
   - Close all open applications.
   - Follow the instructions for your computer for removing programs.
   - After you finish uninstalling earlier versions of Acrobat and PitStop, restart the computer.

2. Close all software applications that are currently running on the computer.

3. Insert the Adobe Acrobat/Enfocus PitStop DVD (Windows or Mac OS) into the DVD drive.

4. If the installer does not start automatically, navigate to the root level of the DVD and double-click Setup.exe (Windows) or Setup.app (Mac OS).

5. On Mac OS X, click Install and follow the on-screen instructions.
   - On Windows, select the language and click Next.

   The SeeQuence software option that you purchased is now fully enabled.

About Help

SeeQuence Suite Help is part of Command WorkStation Help. For instructions on using SeeQuence Impose and Compose, see Command WorkStation Help.

The Help menu offers access to the following kinds of Help:
   - **Online Help** provides procedural information.
   - **How To** accesses the EFI web page, which provides demo scripts and sample files.
   - **What’s New** describes the new features of Command WorkStation.

To access Command WorkStation help

1. Start Command WorkStation.
   - Select the EX Print Server from the Server List dialog box and log on to the server (see “Configuring the connection to the EX Print Server” on page 15).

2. Choose Help, How To, or What’s New from the Help menu.
   - Or press F1 when the cursor is in an area of the main Command WorkStation window.
Paper Catalog is a system-based paper warehouse database that stores attributes of any media available for printing from the EX Print Server. Media entries are defined on the press and listed in Paper Catalog on the EX Print Server. You can then select media for your job from those listed.

**Installing Paper Catalog**

Paper Catalog is installed by default with Command WorkStation.

For information about installing Command WorkStation, see page 13. For information about configuring Command WorkStation, see “Configuring the connection to the EX Print Server” on page 15.

For instructions on how to use the standard Paper Catalog features, see Command WorkStation Help. For instructions on how to access Command WorkStation Help, see page 17.

**Specifying Paper Catalog media for jobs**

This section describes how to specify Paper Catalog media for use with a print job. You can specify Paper Catalog media from the following interfaces:

- Command WorkStation
- Job Properties in Command WorkStation
- Mixed Media Setup in Command WorkStation
- Hot Folders
- SeeQuence Impose
- SeeQuence Compose
- Printer driver (for instructions, see *Printing*)

**Note:** The following procedures assume that one or more Paper Catalog entries have already been defined by an administrator. For information about how to define Paper Catalog entries, see the Paper Catalog section of Command WorkStation Help.
**TO ACCESS PAPER CATALOG FROM COMMAND WORKSTATION**

- To open Paper Catalog from Command WorkStation, choose Paper Catalog from the Server menu or click the Paper Catalog icon in the toolbar.

**TO SPECIFY PAPER CATALOG MEDIA FROM JOB PROPERTIES**

1. Select a job in the Job Center and choose Properties from the Command WorkStation Actions menu.
2. Click the Media icon in the Job Properties dialog box.
3. Choose Paper Catalog from the Media menu, and choose the required media from the Paper Catalog menu.

**NOTE:** If you specify a paper catalog entry and then use Job Properties to change the page size (or another attribute associated with the paper catalog entry), the paper catalog assignment is canceled. Job Properties subsequently displays “none defined” for Paper Catalog.

**TO SPECIFY PAPER CATALOG MEDIA FROM MIXED MEDIA SETUP**

1. Select or right-click a spooled/held job in the Job Center and choose Properties from the Actions menu, or double-click a job.
2. Click the Media icon in Job Properties and scroll down to Mixed Media.
3. Choose Paper Catalog from the Media menu in the Cover Media, Page Range, or Insert Blank windows, and choose the required media from the Paper Catalog menu.

   If Insert Tab is supported, choose from the Paper Catalog menu in the Insert Tab window.

For more information about Mixed Media Setup, see the Mixed Media section of Command WorkStation Help.

**TO SPECIFY PAPER CATALOG MEDIA FROM SEEQUENCE COMPOSE**

1. Select a spooled/held job in the Job Center and choose Compose from the Actions menu.
2. Select a page, or pages, in the Page View pane of the Compose window, and choose Assign Media from the Actions menu.
3. Choose Paper Catalog from the Media menu and select the required media.

For information about using Compose, see the Compose section of Command WorkStation Help. Compose Help also includes information about how to apply Paper Catalog entries to your job.
To specify Paper Catalog media from SeeQuence Impose

1. Select a spooled/held job in the Job Center and choose Impose from the Actions menu.
2. Click the Edit button beside the Sheet menu.
3. Choose Paper Catalog from the Media menu and select the required media.

For information about using Impose, see the Impose section of Command WorkStation Help. Impose Help also includes information about how to apply Paper Catalog entries to your job.

To specify Paper Catalog media from Hot Folders

1. Select Job Settings and click Define in the Folder Properties dialog box.
2. Click the Media icon in the Job Properties dialog box.
3. Choose Paper Catalog from the Media menu, and choose the required media from the Paper Catalog menu.
4. Click OK to return to the Hot Folders Properties window.
Hot Folders is a utility that allows you to store and reuse frequently used print options when printing PostScript and PDF files on the EX Print Server. With Hot Folders, you can do the following:

- Create special folders (hot folders) that assign specific print settings and print queues to jobs.
- Print jobs to the EX Print Server by dragging and dropping them onto hot folders on your computer’s desktop.
- Monitor the status of jobs sent to hot folders.

Installing Hot Folders

The Hot Folders installer is located on the User Software DVD.

Before installing the utility, make sure you complete the preliminary procedures described on page 8.

Upgrading from a previous version of Hot Folders

Hot Folders includes a migration assistant that detects the previous version of Hot Folders and upgrades any existing Hot Folders settings to work in the latest version. The migration takes place only once during the installation of Hot Folders or Command WorkStation. The Migration Assistant summary window indicates whether or not a Hot Folder transferred successfully to the new version, and in case of failure, allows you to retry once during installation without exiting the Migration Assistant.
To migrate folder settings from an earlier version of Hot Folders

1 Install Hot Folders and allow the migration assistant to detect the previous version.
   
   **NOTE:** The Migration Assistant window only appears if there is a previous version of Hot Folders already installed. (Previous versions include: on Windows, all 2.x versions; on Mac OS, all 1.x versions.)

2 Click OK and follow the on-screen instructions.
   
   **NOTE:** Do not click Cancel when migration is in progress. Cancelling the operation may cause permanent damage to the Hot Folders being upgraded.

3 Check the Migration summary in the Migration Assistant window.
   
   If migration is successful, you will see the successful icon (✓) next to each Hot Folder. If migration fails, or only partially succeeds, you will see the failed icon (⚠️) next to the Hot Folders that failed to migrate, with any details highlighted in the lower pane.

4 In case of failure, click Retry to attempt migration again before exiting the Migration Assistant.
   
   **NOTE:** Retrying will generate a new summary, checking only the files that failed.

5 Click OK.

Using Hot Folders

Instructions on how to use the standard Hot Folders features are provided in Hot Folders Help.

To access Hot Folders Help

1 Start Hot Folders.

2 Choose Help > EFI Hot Folders Help.
WebTools

WebTools allow you to manage your EX Print Server remotely from the Internet or your company’s intranet. The EX Print Server has its own home page, where you can select the following WebTools:

- **Home** provides current information on the jobs processing and printing on the EX Print Server.
- **Downloads** allows remote users to download installers (for drivers, PPDs, and other software) directly from the EX Print Server.
- **Docs** allows remote users to access jobs on the EX Print Server over the Internet or intranet.
- **Configure** allows the EX Print Server administrator to view and modify Setup options remotely from a Windows computer.

**Setting up WebTools**

WebTools are accessed through the home page of the EX Print Server web site and do not require special installation. However, WebTools do require initial Setup by the EX Print Server administrator.

To enable network users to access and use WebTools, the administrator must set specific options in Network Setup and Printer Setup. For information about these specific Setup options, see *Configuration and Setup*.

The administrator also must prepare each user’s computer to communicate with the EX Print Server over the Internet or intranet.
To set up client computers to use WebTools

1. Enable TCP/IP networking.
2. Make sure that the workstation has a valid, unique IP address.
3. Make sure that a supported Internet browser is installed on the computer.
   For more information on supported browsers, see Welcome.
4. Make sure that Java is enabled in your Internet browser.

In addition, make sure that you have completed the preliminary procedures described on page 8.

Note: If the client computer is running Windows XP with Service Pack 2 (SP2) or Service Pack 3 (SP3), or Windows Vista, Pop-up Blocker is turned on by default. With this function turned on, a warning message appears when you access WebTools, and your access to WebTools is denied. To gain access, do one of the following:

- Change the Pop-up Blocker setting by clicking the warning message and choosing from one of the selections that appears.
- Turn off Pop-up Blocker in Internet Explorer from the Tools menu or in Internet Options.

For more information, see Internet Explorer Help, or the documentation that accompanies the Windows operating system.

Accessing the WebTools home page

Use your Internet browser to access WebTools. For complete information about browser and system requirements, see Welcome.

1. Start your Internet browser.
2. Type the IP address or DNS name of the EX Print Server.
   The EX Print Server home page appears.
3. Click the tab for the WebTool that you want to use.
Using WebTools

The following sections describe how to use the WebTools.

Home

Home lets you view jobs that are currently processing and printing on the EX Print Server. Printing and processing information is updated every 30 seconds.

For complete instructions on how to use Home, see the online Help.

Downloads

The Downloads WebTool allows you to download installers (for drivers, PPDs, and other EX Print Server software) directly from the EX Print Server.

For complete instructions on how to use Downloads, see the online Help.

Docs

Docs allows you to access jobs on the EX Print Server over the Internet or intranet. You can:

- Manage and distribute jobs in your mailbox.
  Mailboxes are set up in the Configure WebTool.
- Control and modify jobs.
- Submit jobs to the EX Print Server.

For complete instructions on how to use Docs, see the online Help.

Configure

Configure allows the EX Print Server administrator to view and modify Setup options remotely from a Windows computer. For information about using Configure, see Configuration and Setup.

Before using Configure, make sure you have completed the Configure preparation procedure described in page 8.

For complete instructions on how to use Configure, see the online Help.
INDEX

A
accessing Help 17
  for Command WorkStation 17
  for Hot Folders 39
  for SeeQuence Suite 34
Administrator login 16, 17
Adobe Acrobat and Enfocus PitStop
  description 32
  installing 33

B
blank pages, inserting 20

C
chapter definition for jobs 19
color management 7
Command WorkStation
  accessing Help 17
  Device Center 13
  Job Center 13
Compose, about 31
Configuration page
  description 15
  printing 15
Configure WebTool 42
configuring
  server 42
  WebTools 40, 41
configuring connection to server
  for Command WorkStation 15
conventions 6
cover media 21
cover settings 20

D
Device Center 13
Docs WebTool 42
Domain Name Server (DNS) 15
dongle
  for SeeQuence Suite 31
downloading software 42
Downloads WebTool 42
drag-and-drop printing 38

E
EFI ImageViewer 29
  enabling
    SeeQuence Suite 32

F
Fiery User Software Installer 9, 11
full-screen preview 29

G
Graphic Arts Package, Premium Edition
  ImageViewer 29

H
Help
  for Command WorkStation 17
  for Hot Folders 39
  for Paper Catalog 35
  for SeeQuence Suite 34
  for WebTools 42
Home WebTool 42
Hot Folders
  accessing Help 39
  description 38
  installing 38
  using 39

I
icons, in documentation 6
ImageViewer 29
Impose, about 31
imposing jobs 31
imposition layouts 31
Insert Tabs 26
inserting
  blank pages 20
  tabs 26
installing
  Compose 32
  Hot Folders 38
  Impose 32
  Paper Catalog 35
  SeeQuence Suite 32
  user software 8
installing on Mac OS 11
IP address 15

J
Java 41
Java file 8
installing 8
Java runtime Environment (JRE) 8
Job Center 13
jobs
chapter definitions 19
cover media 21
mixed media definitions 18
VDP 31

L
logging in to the server 16

M
media definitions 18
media settings
cover 20
Mixed Media 18

P
Paper Catalog
accessing
from Command WorkStation 36
description 35
installing 35
specifying media
from Compose 36
from Hot Folders 37
from Impose 37
from Job Properties 36
from Mixed Media 36
paper definitions 18
preview window 29
printing with frequently used print options 38
product names
terminology 6

R
remote setup 42

S
SeeQuence Compose See Compose 31
SeeQuence Impose See Impose 31
SeeQuence Suite
accessing Help 34
description 31
kits 31
SeeQuence Suite See Impose and Compose 31
server setup 42
servers, searching for 15
Sun Java JRE 8

T
tab
insertion 26
media 26
tab printing 20
text attributes 28
tab text, specifying 27
tabs, unused 29
terminology 6
terminology for product names 6
text attributes on tabs 28
text on tabs, specifying 27
troubleshooting
Command WorkStation 30

U
user software
for SeeQuence Suite 32
installing from media 8
installing on Mac OS 11
installing on Windows 9
installing over the Internet 8
installing over the network 8
modifying on Windows 10

V
VDP jobs
imposing 31

W
WebTools
Configure 42
configuring 41
Docs 42
Downloads 42
Home 42
home page 10, 12, 41